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LINK ENGINE MANAGEMENT LTD – LIMITED LIFETIME WARRANTY

All Engine Control Units (ECUs) manufactured or distributed by Link Engine Management Ltd are
subject to the following LIMITED LIFETIME WARRANTIES, and no others.

Link Engine Management Ltd warrants only to the original purchaser of the ECU, for the lifetime of
the ECU, (subject to the limitations set out below), that the ECU shall be free from defects of
materials and workmanship in the manufacturing process. This warranty ceases to apply and does
not apply to ECUs that have not been manufactured or distributed by Link Engine Management Ltd
for a period of greater than one year.

An ECU claimed to be defective must be returned to the place of purchase. Link Engine Management
Ltd, at its sole option, may replace the defective ECU with a comparable new ECU or repair the
defective ECU. 

This limited lifetime warranty is not transferable and does not apply to any ECU not properly installed
or properly used by the purchaser or end user, or to any ECU damaged or impaired by external
forces. The above warranties are the full extent of the warranties available on the ECU. Link Engine
Management Ltd has no liability to the original purchaser or any other person for any loss, injury or
damage to persons or property resulting from the use of the ECU or any failure of or defect in the
ECU whether by general, special, direct, indirect, incidental, consequential, exemplary, punitive, or
any other damages of any kind or nature whatsoever. Link Engine Management Ltd specifically
disclaims and disavows all other warranties, express or implied, including, without limitation, all
warranties of fitness for a particular purpose, warranties of description, warranties of merchantability,
trade usage or warranties of trade usage.

For off-road use only, not intended for highway vehicles. This ECU contains a user-configurable
software programme, which is updated by Link Engine Management Ltd from time to time. The user
must ensure the current correct version of this programme is downloaded from the website of Link
Engine Management Ltd and installed in the ECU prior to use. This limited lifetime warranty does not
apply where the ECU has been installed with the incorrect version of the software programme. The
user is solely responsible for the setup and testing of all user-configurable features. 

Link Engine Management Ltd License Agreement

The software programme in this ECU is licensed not sold. Link Engine Management Ltd grants the
user a license for the programme only in the country where the programme was acquired. No other
rights are granted under this license and the programme may only be used on one machine at a
time. If the programme is transferred a copy of this license and all other documentation must be
transferred at the same time. The license may be terminated by the user at any time. Link Engine
Management Ltd may terminate the licence if the user fails to comply with the terms and conditions
of this license. In either event the copy of the programme must be destroyed.

Product Warranty Statement
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1 G4X Plug-In ECU Installation Manual

1.1 Introduction

Thank you for purchasing your Link Plug-In Engine Control Unit (ECU), an advanced, fully programmable
microprocessor controlled Engine Management System.
G4X software employs high resolution fuel and ignition tables with configurable load and RPM centres. When
coupled with up to six dimensional fuel and ignition mapping, barometric pressure compensation and intake
air temperature correction this gives an unprecedented level of tuning accuracy. All Link G4X ECUs are in-field
upgradeable, there is no need to return the unit for software updates.
All Link G4X Plug-In Engine Management Systems are designed with flexibility and ease of installation in
mind. Link Plug-In systems are designed to replace the circuit board inside the factory ECU enclosure. This
provides an invisible install that requires minimal modification to vehicle wiring and ECU mounting.
Installing and tuning any after market engine management system is not to be taken lightly. G4X ECUs give
the tuner the control & flexibility that only top after-market engine management systems in the world can
provide. While every effort has been made to keep G4X ECUs as user friendly as possible, it should be
recognised that added features bring added complexity.
The complete setup of your ECU can be divided into two important tasks:
1. This manual covers the installation of your G4X ECU. While it is not strictly essential that this work is

performed by an automotive electrician, the knowledge and tools available to these professionals makes it
highly recommended. Regardless of who does the installation, it is of utmost importance that instructions
provided in this manual are followed exactly throughout the installation.

2. Once the G4X ECU has been installed it will need to be tuned using a laptop computer with PCLink
software. Information on the configuration and tuning of the G4X ECU is detailed in the help section of
PCLink. G4X ECUs are shipped pre-loaded with a base configuration that should be close enough to get
most engines running after a few application specific adjustments have been made. While hearing the
engine running on the new ECU for the first time is always a satisfying feeling, it is important to realise
that the job is not complete. The amount of tuning performed and the experience of the tuner are the two
most important factors in determining how happy you will be with your engine management system.

1.1.1 Safety Notice

Your Link Plug-In ECU is designed to enhance the performance of your vehicle. However in all cases, your
vehicle must be operated in a safe manner. Do not tune your vehicle while operating it on public roads.

WARNING!
Failure to follow all installation and operating instructions may result in damage to

the Link ECU, personal injury, or harm to property.

1.1.2 Disclaimer

All care has been taken to ensure the pin outs and interconnections of the ECU to the vehicles wiring harness
are correct. However due to variations between vehicle models it is the installers responsibility to check wiring
connections BEFORE installing the ECU. Link will not be held responsible for any damage caused by the
incorrect installation of this product.

1.1.3 Support Options

Should any issues arise during installation, the following options exist for technical support:
1. PCLink help, press F1 while running PCLink
2. Contact your nearest Link dealer. A Link dealer list is available on our website.
3. Link website: www.linkecu.com with Online Discussion Forum.
4. Technical Support Email: tech@linkecu.com
The majority of questions received by the technical support team are clearly answered in the manuals. Please
consult the manuals to make sure that your question has not already been answered.

1.2 Pre-Installation

Before installing the Link G4X ECU into the vehicle some pre-installation checks must be performed. 
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1.2.1 Board Switch Settings

Some Link G4X ECUs require switches on the board to be set before installation.

1.2.1.1 DC5 Honda Integra Type R

The G4X DC5 Honda Integra Type R plug-in ECU has a Jumper which enables the user to connect either the
factory MAP sensor (Pin A19) or the onboard MAP sensor to An Volt 1, a diagram is provided on the PCB to
indicate how the jumper should be installed for each setup. The calibration in the provided sample map is
setup for the factory MAP sensor.

1.2.2 Staged Injection Upgrade

A staged Injection upgrade is available for the following ECUs.

1.2.2.1 DC5 Honda Integra Type R

Injectors 5, 6, 7 & 8 are all available on the main header and can be used for injection with some rewiring of
the factory harness, this means that if it is desired it is relatively easy to setup sequential staged Injection.

1.3 Installation

This guide provides information on correctly and safely installing your new Link G4X Plug-In ECU.

1.3.1 ECU Handling Procedures

WARNING!!!
The following installation process will require handling of both the Link ECU and

factory ECU. Both of these are highly sensitive to electrostatic discharge and are
easily damaged. Follow the anti-static precautions given in this manual carefully

to avoid damaging electronic components. Warranty claims for ECUs damaged by
electrostatic discharge will NOT be accepted.

ANTI-STATIC HANDLING GUIDELINES

Your body builds up an electrical charge as you move around. This charge can reach very high
voltages. Whenever given the opportunity this energy will attempt to discharge (usually through

your finger tips!). This can be fatal to most electronic components. Most people have
experienced an electrostatic discharge when they step out of their car or touch a metal bench

top. 
The following guidelines describe precautions that can be taken to reduce the possibility of

damaging your ECU:

1. Work only on a conductive surface. A clean steel bench is suitable.
2. Always wear a wrist strap that is electrically connected to the conductive 

working surface. An Anti-static wrist strap is included for use during install
3. Touch the working surface regularly.
4. Do NOT touch components on the circuit board.
5. Where possible, only handle the ECU by its plastic header.
6. Do NOT carry the ECU around without anti-static packaging. 
7. Do NOT touch the bare terminals in the ECU header.

Observing the above procedures will minimise the chance of damaging the ECU. Note that
failure due to static damage often does not appear until well after it was caused.
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1.3.2 Fitting the ECU

Information is provided to assist in fitting the ECU into the vehicle.

1.3.2.1 DC5 Honda Integra Type R

The following steps outline the installation procedure:
1. Remove the factory ECU from the vehicle: Ensure the key is in the OFF position. The factory ECU is

located in the passenger foot-well attached to the underside of the AC/Heater system, some interior
plastics will need to be removed to get to it. Remove the 6mm bolts (10mm socket) that retain the ECU
and Unplug the wiring harness from the factory ECU. Remove the ECU from the vehicle. DO NOT touch
the exposed pins in the factory ECU connector.

2. Remove the factory ECUs circuit board from its enclosure: Ensure you are following the given anti-static
guidelines and ARE WEARING A CONDUCTIVE WRIST STRAP connected to a conductive working
surface. Note there are two smaller bolts on the side of the ECU that clamp components to the case
which need to be loosened.

3. Connect the ECU USB tuning cable and the expansion loom if required.
4. Install the Link ECU circuit board into the enclosure, then fit the enclosure into the vehicle.
5. Connect the ECU to the factory wiring loom.
6. Do NOT attempt to start the vehicle. Proceed to read through the remaining sections of this manual first.

1.4 Additional Sensors/Functions

G4X Plug-In ECUs offer various options for the installation of additional sensors and devices. As a minimum it
is recommended that all ECUs are installed with a Manifold Absolute Pressure (MAP) sensor and Intake Air
Temperature (IAT) sensor. These parts can be purchased if required from your nearest Link dealer. 

1.4.1 MAP Sensor

It is important that the pressure source for a MAP sensor be taken from a stable pressure source after the
throttle body. It is common to 'T' into the fuel pressure regulators pressure signal. Do NOT share this signal
with other devices such as boost gauges or blow off valves.

Note: Internal MAP Sensors on new plug-in ECUs have changed from 4Bar to 7Bar. The 7Bar versions should
be identifiable by a sticker on the bottom board and can also be confirmed by comparing MAP and BAP when
the MAP vacuum line isn't connected to see if they match with the calibration being used.

1.4.1.1 DC5 Honda Integra Type R

The G4X DC5 Honda Integra Type R Plug-In ECU supports several options for fitting of a MAP sensor. Any
one of the following options can be used:
1. Factory MAP Sensor – The factory MAP sensor is wired to An Volt 1 via a jumper on the bottom board.

Ensure the jumper is setup to use the factory sensor and that the MAP Calibration is set to Honda K20.
2. Internal MAP Sensor – This Plug-In ECU has an on board MAP Sensor connected to An Volt 1 via a

jumper on the bottom board. Ensure the jumper is setup to use the internal sensor and that the MAP
Calibration is set to 7 Bar. This sensor rated to 7.0 Bar absolute pressure (6.0 bar boost).

3. MAP Via Expansion Connector - The expansion connectors provide power, ground, and analog channels
for the connection of a MAP sensor.

Make sure that the correct MAP sensor input has been selected in PCLink and a MAP calibration has been
performed before attempting to start the vehicle.

1.4.2 IAT Sensor

It is highly recommended that an IAT sensor be fitted in all applications to provide an input for correction of
fuel and ignition based on the engines air charge temperature.
An IAT sensor should be fitted in the intake system in a location that accurately represents intake
temperature. The most common location is just prior to the throttle body. Installing in the manifold is not
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recommended due to heat soak issues. A fast response sensor must be used in all forced induction
applications.

1.4.2.1 DC5 Honda Integra Type R

From factory, models supported by the G4X DC5 Honda Integra Type R Plug-In ECU are fitted with an IAT
sensor. The G4X DC5 Honda Integra Type R Plug-In ECU supports several options for fitting of an IAT sensor.
Any one of the following options can be used:
1. Factory IAT – An Temp 2 is wired to the factory IAT sensor.
2. IAT Through Expansion Connector - The expansion connectors provide ground and temperature channels

for the connection of an IAT sensor. Wire the sensor between the Ground pin and an An Temp channel
pin. Note spare An Volt channels can be used as temperature inputs when a pullup resistor (to +5V) is
added.

1.4.3 E-Throttle Output

1.4.3.1 DC5 Honda Integra Type R

This ECU has a dedicated E-Throttle Expansion Connector which contains Aux 9 & Aux 10 and four An Volt
inputs. Aux 16 is setup to control the E-throttle power and so needs to be set as the E-Throttle Relay.

1.4.4 Expansion Connector

Expansion connectors are provided to allow easy connection of additional ECU inputs. An “expansion cable”
can be purchased from your Link dealer. 
Important points when wiring to the expansion connector:
· Do not overload the +5V Out pin. Although this is protected against ECU damage the +5V out signal also

provides power for other sensors.
· Do not connect the ground pin to chassis ground. This could cause ground loops and introduce

unnecessary interference. Use this pin only to ground external sensors that are isolated from chassis
ground.

The Expansion connectors available for each ECU can be found under the Pinouts Section.

1.5 PC Tuning

G4X ECUs require PC/laptop tuning using the PCLink Tuning Software application running on a Windows
based computer. PCLink may be downloaded from www.linkecu.com. Note that when new versions of PCLink
are released they are posted on the website and may be downloaded at no cost. Also note that G4X ECUs
must be used with the correct version of PCLink.

IMPORTANT!
The G4X ECU has on board USB.

BEFORE connecting the ECU to your laptop, the USB drivers must be installed.
Failure to install the drivers on your laptop first may result in windows assigning
incorrect drivers. These drivers will not work with the G4X ECU and are difficult to
uninstall. The correct USB drivers are installed as part of PCLink installation, as
described in the following section. Should internet download not be practical, a

copy of the drivers on CD can be obtained from your nearest Link dealer.

1.5.1 Installing USB Drivers

Before connecting the ECU to your laptop or PC, the ECU USB drivers must be installed. These drivers are
installed as part of PCLink installation as described in the following section.

1.5.2 Installing PCLink Tuning Software

Due to the frequent updates PCLink is no longer shipped with each ECU. You will be required to download the
latest version of PCLink from: linkecu.com
Should access to an Internet connection be impractical, download the latest version of PCLink elsewhere to a
USB drive, and then install on your laptop.
Installing from the web
1. Go to the above website and navigate to the downloads and software updates section.
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2. Download the latest version of PCLink. When prompted to run or save the file, select save. It is
recommended to save this file on the desktop.

3. Double click the saved file and follow on screen instructions.
4. When prompted to install USB drivers, select yes. This may take some time.
5. When installed, open PCLink by double clicking on the icon that has been placed on the desktop.

1.5.3 Communicating With Your ECU

After PCLink installation, you will be able to connect the G4X ECU to the laptop to perform set-up and tuning
work.
1. Connect the ECU to your laptop using a Link G4X ECU USB Cable. If not supplied with the ECU, these

can be purchased from a Link dealer. No other adapter or cabling is required. Connect the cable to the
connector labelled USB.

2. If this is the first time you have connected a G4X USB ECU to your laptop follow the driver installation
instructions that appear. When prompted if you want to install drivers select 'Continue Anyway'.

3. Start PCLink by double clicking on the PCLink icon on the windows desktop.
4. Switch the key to the ON position. This will provide power to the ECU.
5. In PCLink, under the 'Options' menu, select 'Connection'. The connection options dialogue will open.

Select the correct COM Port number from the drop down list or select auto for automatic com port
detection.

6. PCLink offers both mouse and keyboard control. To establish a connection between the PC and ECU
press the F3 key. The same process can be used to disconnect. If a successful connection is
established, PCLink will download settings from the ECU, otherwise you will be warned that an error has
occurred.

7. Make sure the connection shows “ONLINE” in the top right corner of PCLink.
8. To permanently STORE any changes made to the ECU press F4. If this is not done before turning the

ECUs power off all changes made will be lost.

1.6 Pre-Start Configuration

Before starting the vehicle, important pre-start configurations need to be made.

1.6.1 Firmware Version

It is recommended to ensure that the Link G4X ECU is running the most up to date firmware. Firmware
version information can be obtained by connecting to the ECU with PCLink and selecting 'ECU Information'
under the Help menu.
The latest firmware can be downloaded from our website with PCLink. 
It is recommended that this is performed by an experienced Link dealer as new features may need to be
properly configured.
The firmware can be updated by selecting 'Update Firmware' under the 'ECU Controls' menu in PCLink, follow
the on screen instructions to complete the firmware update process.

1.6.2 Base Configuration

All G4X Plug-In ECUs are shipped with base configuration settings. Note that these are provided to reduce
initial setup and tuning times. They are NOT recommended tuning values. PCLink includes base
configurations for various models. Download the appropriate base configuration into your ECU with PCLink by
connecting to the ECU (described in the Connecting To PCLink section of this manual), then selecting 'Open'
under the 'File' menu. Select the appropriate .pclx file and then select 'Open'. Downloading large configuration
files can take up to a few minutes. Be patient and acknowledge any messages PCLink shows.

1.6.3 MAP Sensor Calibration

At key on and engine not running the Manifold Absolute Pressure (MAP) Sensor should always match the
Barometric Absolute Pressure (BAP) Sensor. As well as providing altitude correction, the BAP sensor also
allows the MAP sensor to be calibrated prior to tuning.
Link G4X ECUs use an on-board barometric sensor that is calibrated prior to dispatch. This ensures that all
PCLink Tuning Software programs (pclx Files) give a consistent state of tune throughout the ECU range. This
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allows a pclx file to be transferred between G4X based ECUs giving an equivalent state of tune providing all
factors affecting volumetric efficiency are equal.
Without the ability to calibrate all the available types of MAP Sensors to the BAP Sensor there would be
significant affects on the accuracy of the resulting tune, especially when tuning with Manifold Gauge Pressure
(MGP) as a load index.
To calibrate the MAP sensor:
1. Connect a laptop/notebook PC to the ECU and connect to the ECU using PCLink.
2. Under the Analog Channels menu, select the An Volt channel that has been wired to the MAP sensor.

Select the correct MAP Sensor Type.
3. Under the 'Options' menu, select 'MAP sensor calibration'.
4. Follow the on screen instructions.
5. Select the 'Analog Inputs' tab in the runtime values section of PCLink (lower part of the screen).
6. Compare the MAP and BAP values and ensure they have a similar reading (within 1 kPa).
7. Perform a 'Store' by pressing F4.

A more in depth explanation is provided in the PCLink help Manual under PCLink G4X Users Manual ->
Tuning Operating Procedures -> ECU Controls -> MAP Sensor Calibration.

1.6.4 TPS Calibration

Non E-Throttle Vehicles:
The Throttle Position Sensor (TPS) is used by the ECU to calculate various engine management parameters
used by functions such as idle speed control,acceleration enrichment and motor sport features. It is important
that the ECU knows when the throttle is open and closed (or part way in between). The following procedure
calibrates the ECU to match the TPS and is for engines using a cable driven throttle:
1. Connect a laptop/notebook PC to the ECU and connect to the ECU using PCLink.
2. Open Analog Inputs ->Throttle Position Sensor and ensure that the TPS (Main) Source is set to the

correct input. Refer to the Pinouts section of this manual for details.
3. Under the 'Options' menu, select 'TPS calibration'.
4. Follow the on screen instructions.
5. Select the 'General' tab in the runtime values section of PCLink (lower part of the screen).
6. Ensure the Throttle Position value reads 0% when the throttle is closed and 100% when fully open.
7. Perform a 'Store' by pressing F4.

1.6.5 IAT Sensor Selection

This section only applies when an Intake Air Temperature (IAT) sensor has been wired and fitted to the intake
system. It is important that the ECU is calibrated to match the sensor installed in the engine. This procedure
is as simple as selecting the correct sensor type as follows:
1. Connect a laptop/notebook PC to the ECU and connect to the ECU using PCLink.
2. Click on 'Analog Channel' in the configuration tree.
3. Select the An Temp channel the sensor has been wired to.
4. Ensure that channel (and only that channel) is set to 'Inlet Air Temperature'.
5. Select the correct 'Temp Sensor Type'.
6. Select the 'Analog Inputs' tab in the runtime values section of PCLink (lower part of the screen).
7. Ensure that IAT reads the correct temperature.
8. Perform a 'Store' by pressing F4.

1.6.6 Input and Output Setup

As the Link G4X Plug-In ECUs are designed to run several models there are a few items that must be set-up
to make the ECU specific to your model. 
The Pinouts section of this manual gives a list of the functions of each channel based on the target vehicle.
It is the tuners responsibility to make sure that the following channels are set-up correctly for the vehicle
model the ECU is fitted to:
All Auxiliary Output Channels 
Use the 'Test On' or 'Test PWM' (at 10 Hz) functions to test the wiring of channels.
All Digital Inputs
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Look at the Digital Inputs runtime values (lower section of the PCLink screen) to confirm each channels
operation.
All Analog Volt and Temperature Inputs
Look at the Analog Inputs runtime values (lower section of the PCLink screen) to confirm each channels
operation.

1.6.7 Trigger Calibration

The following instructions assume that all pre-start set-up instructions given in previous sections have been
completed. Only after all pre-start checks have been made should an attempt be made to crank the engine.
The following steps must be performed before an attempt is made to start the engine to ensure the G4X ECU
is calibrated to precisely measure engine position.
1. Connect the ECU to PCLink.
2. Select 'Fuel', then 'Fuel Set-up':

a. Set ‘Injection Mode’ to OFF. This will prevent the engine from trying to start while the triggers are
calibrated.

b. Perform a Store (press F4) to make sure fuelling is not re-enabled if power to the ECU is lost.
3. Click on ‘Triggers’ then ‘Calibrate Triggers’.
4. Perform the correct trigger calibration procedure specific to your vehicle as described in the PCLink help

(Press F1).
Note that trigger calibration must be performed again once the engine is running. Due to the acceleration and
deceleration of the crankshaft at low speeds, an inaccurate measurement of engine timing is usually made.
Also it is often harder to see timing marks with a timing light at slow engine speeds. Trigger calibration should
be checked again at between 2000-4000 RPM where engine speed is stable and a more consistent timing
reading can be obtained.

A more in depth explanation is provided in the PCLink help Manual under G4X ECU Tuning Functions ->
Triggers -> Calibration.

1.7 First Time Startup

For further help on any of the settings discussed below, consult the Help in PCLink Tuning Software. Help
can be invoked by pressing F1, or right clicking any item and selecting ‘What’s this?’.

Pre-set-up Checks
Before attempting to configure the ECU, ensure the following tasks have been completed:
1. Ensure the ECU and all associated components are connected and correctly wired/installed.
2. Fully charge the vehicle’s battery, as the engine will be required to be cranked during the set-up

procedure.
3. Check all oil and water levels are correct.

Connecting to PCLink Tuning Software
Use the following procedure to establish a connection between your Link ECU and PCLink Tuning Software
tuning software.
1. Make sure your laptop battery is fully charged or plugged in to mains power.
2. Connect the ECU to your laptop and connect to PCLink as described in the 'Communicating with your

ECU' section of this manual. 

First Time Startup
After performing all set-up instructions given in previous sections, including trigger calibration, the engine is
now ready to be started. The following procedure should be used for first time start-up.
1. Turn the ignition key OFF then ON. The fuel pump should prime momentarily upon power up.
2. Connect the ECU to PCLink.
3. Access the runtimes values by pressing the F12 Key, click the 'Analog' tab:

a. TPS – spans from 0 to 100% when throttle is pressed. If not, perform a TPS Calibration. If the vehicle
has an E-Throttle confirm that APS (Sub), APS (Main), TPS (Sub), TPS (Main) all operate correctly
and that the throttle blade tracks the target correctly.

b. MAP – should read approx 101 kPa (at sea level) with the engine not running. If not, check the MAP
Sensor Type setting and perform a MAP Calibration.
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c. ECT – should read current engine temperature.
d. IAT – should read current intake air temperature.
e. Digital Inputs (click the 'Digital' tab) – Operate switches connected to any digital inputs while watching

the runtime value to ensure they operate as expected.
4. Rectify any faults found in Step 3.
5. Ensure the basic Fuelling setup is correct.

a. If using Traditional Fuel Equation Mode then locate the 'Master Fuel' setting in the ECU Settings Menu
under: Fuel > Fuel Setup > Fuel Main. This will need to be adjusted during or just after start-up.

b. If using one of the Modelled Fuel Equation Modes then navigate to Fuel > Fuel Setup > Fuel main and
enter the correct engine capacity, correct base fuel pressure, and correct fuel properties. Navigate to
>Fuel>Fuel Setup>Injector Setup, enter correct injector flow rate and rated pressure.

6. Crank the engine until it starts. Some throttle may be required for first time start-up due to imperfect
tuning.
a. If using Traditional Fuel Equation Mode the Master Fuel settingcan be used to enrich/lean the engine

(increase to enrich).
b. If using one of the Modelled Fuel Equation Modes the Injector Flow Rate can be decreased to add

more fuel, this will need to be changed back to the correct value later but works well for first start
purposes.

7. If the engine fails to start after several attempts, do not crank it endlessly. Stop and determine the
problem before continuing.

8. Check the Trigger Error Counter (found under the Triggers runtime values tab). If this value increases
during cranking/running then there is a trigger setup fault. It is not unusual for this number to count one or
two on the first engine revolution.

9. Once the engine starts:
a. If using Traditional Fuel Equation Mode adjust the Master Fuel setting to achieve best possible running
b. If using one of the Modelled Fuel Equation Modes adjust the Injector Flow Rate setting to achieve best

possible running, this will need to be changed back to the correct value later but works well for first
start purposes.

10. The engine should now be allowed to fully warm up. It may be necessary to readjust ‘Master’ several
times to maintain smooth running. Don’t forget to keep an eye on engine temperature.

11. Once the engine is warmed up and running well, perform another trigger calibration (known “as setting the
base timing”).

12. Perform a Store by pressing F4.

Essential Tuning Adjustments
It is assumed that at this stage all set-up procedures described in previous sections have been completed
and the engine is running. The following steps detail correct set-up procedures for some of the more critical
ECU parameters (note that MAP Sensor Calibration should have already been completed by now):

Injector Voltage (Dead-time) Correction
There is always a delay between the injector being energised and the injector actually opening. Likewise,
there is a small delay between the injector being de-energised and the injector closing. The opening time is
considerably longer than the closing time, however the overall result is that less fuel will flow for a given pulse
width than would be expected with an 'ideal injector'. To compensate for this the injector pulse widths are
increased to compensate for this 'dead-time'. The dead-time for a given injector is a function of the battery
voltage, differential fuel pressure and the type of injector driver (saturated or peak and hold). A typical dead-
time at 3 Bar differential fuel pressure and 14 volts is just under 1ms (ms = millisecond = 1 thousandth of a
second). 
In applications with a linear 1:1 fuel pressure regulator (i.e. not a rising rate regulator), the differential fuel
pressure (difference between manifold pressure and fuel pressure) will be constant. Therefore the only variable
that is changing will be the battery voltage (this changes with electrical load and sometimes engine speed).
Without correction, the changes in dead-time will cause the engine to run lean when the voltage drops. If the
Injector Voltage Correction is properly set-up then changes in the battery voltage will not affect the air/fuel
ratio.
The injector dead-time table allows the dead-time for different battery voltages to be entered. The values
represent the dead-time in milliseconds. These should increase with falling system voltage.
Injector dead-time for a particular set of injectors can be determined using a flow bench or on a running
engine. 
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To determine the injector dead-time using a flow bench, the injectors need to be operated at the intended
operating pressure (normally three bar) and at a constant duty cycle as well as a set voltage. Vary the supply
voltage to the injector and measure minimum pulse width at which the injectors will flow for a particular
voltage. This is the required dead-time for that injector at that tested voltage. 
To determine injector dead-time on a running engine, with the engine fully warmed and operating at stable
air/fuel ratios (a very precise AFR meter is required – a narrow band O2 sensor will not suffice), electrical
drain needs to be applied to the system; the preferred method is disconnecting the alternator main fuse.
Battery load testers are also useful here too.
Watching the air fuel ratios change while the battery voltage drops, the dead-time table can be trimmed to
maintain the same stable air/fuel ratio. Injector dead-time can be viewed as a row graph. A smooth curve
needs to be maintained at all times.
NOTE: any change to the fuel pressure or injectors will require a recalibration of the injector dead-times.

Traditional Fuel Equation Mode Master Fuel Setting
If using Traditional Fuel Equattion mode the Master Fuel setting should be set so that the numbers in the
middle of the fuel table end up around a value of 50. This is to allow sufficient span of the numbers in the main
fuel table.

1.8 Pinouts

Pin information is provided to assist when troubleshooting. All pinouts are looking into the ECU (wire side).

1.8.1 DC5 Honda Integra Type R

Pin ECU Pin ECU Function Pin ECU Pin ECU Function

A1 Injector 7
(Aux)

NB O2 Heater Control E1 Aux 1 Fuel Pump Relay

A2 +14V ECU
Power

E2 An Volt 7 Secondary NB O2 Signal

A3 +14V ECU
Power

E3 Ground

A4 Ground
(Power)

E4 Ground (Signal)

A5 Ground
(Power)

E5 +5V Out

A6 An Volt 11 NB O2 Signal E6 Injector 8 (Aux) Secondary NB O2 Heater
Control

A7 Trigger 1 Crank Position Sensor E7 Main Relay Controlled by Ignition
Switch (E9)

A8 An Volt 10 Intake Runner Position,
(2002-2004 RSX K20A3

and 2002-2004 CRV
K24A1 only)

E8 Injector 5 (Aux) O2 Heater Control Relay
(Controls +12V supply to

both NB O2 heaters)

A9 Knock 1 Knock Sensor E9 DI10 Ignition Switch Input

A10 Ground
(Signal)

E10 nc
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A11 Ground
(Signal)

E11 nc

A12 Aux 5 Idle Solenoid (IACV) E12 nc

A13 An Volt 12 EGR Position, (2001-
2005 Civic

D17A2/D17A6 only)

E13 nc

A14 Injector 6
(Aux)

Secondary O2 Heater,
(2001-2005 Civic

D17A2/D17A6 only)

E14 An Volt 9 Fuel Tank Pressure

A15 An Volt 2 TPS E15 An Volt 8 Electrical Load

A16 Ground
(Signal)

Primary O2 Signal
Ground

E16 DI 3 PS Pressure Switch

A17 nc E17 nc

A18 DI 2 Vehicle Speed E18 Ignition 6 (Aux) AC Clutch

A19 An Volt 1 Factory MAP Sensor
(Via Jumper)

E19 nc

A20 +5V Out E20 Aux 12 EVAP emissions bypass
solenoid valve

A21 +5V Out E21 Aux 11 EVAP emmisions canister
vent shut valve

A22 nc E22 DI 4 Brake Pedal Switch

A23 Ground E23 nc

A24 Ground E24 KLine Communicates with vehicle
(temp gauge, ac switch,

batt light)

A25 DI 1 VVT Cam Position (K
Series)

E25 nc

A26 Trigger 2 Cam Sync Sensor E26 Aux 3 Tacho

A27 Ignition 4 Ignition E27 KLine Communicates with the
Immobiliser

A28 Ignition 3 Ignition E28 nc

A29 Ignition 2 Ignition E29 nc

A30 Ignition 1 Ignition E30 nc

A31 nc E31 Ignition 5 (Aux) CE Light

B1 +14V Out VTC Oil Control Sol +ve

B2 Injector 4 Injection

B3 Injector 3 Injection

B4 Injector 2 Injection

B5 Injector 1 Injection

B6 Aux 13 Radiator Fan Relay On-Board MAP An Volt 1 Jumper connects An Volt 1
to this or A19

B7 Aux 4 Reverse Lockout
Solenoid (K20A2)

E-Throttle Relay Aux 16 Only used when adding E-
Throttle

B8 An Temp 1 ECT On-Board power
Relay

Aux 15 Used to prevent back
feeding

B9 DI 5 VTEC Oil Pressure
Switch

Expansion 1 Ground (Signal)
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B10 nc Expansion 2 +5V Out

B11 nc Expansion 3 Aux 9

B12 nc Expansion 4 Aux 10

B13 nc Expansion 5 An Volt 4

B14 nc Expansion 6 An Volt 5

B15 Aux 14 VTEC Solenoid (Drives
High Side)

Expansion 7 An Volt 6

B16 nc Expansion 8 An Volt 3

B17 An Temp 2 IAT Expansion 9 An Temp 4

B18 Aux 8 Alternator Control Expansion 10 An Temp 3

B19 nc Expansion 11 DI 9

B20 nc Expansion 12 DI 8

B21 Ignition 8
(Aux)

Evap Purge Expansion 13 DI 7

B22 Ignition 7
(Aux)

Intake Runner Control Expansion 14 DI 6

B23 Aux 2 VTC Oil Control Sol -ve Expansion 15 Aux 7

B24 nc Expansion 16 Aux 6

Note: AC Request is received over KLine on CAN DI 1
Note: Aux 15 needs to be on for ECU to work correctly (active low).
Note: Aux 8 (Alternator Control) is a switched output which can be used to change between two distinct
charging voltages (~13V output On active Low or ~14.5V Output Off). Use a GP Output if you want to use this
functionality. Some Alternators from newer vehicles (such as 104210-4732) are PWM controlled instead of
being switched.

1.9 CAN Information

The following CAN (Controller Area Network) information is provided:

1.9.1 DC5 Honda Integra Type R

CAN bus 1 and 2 each use a 4 pin connector with the same pinout as shown below.

CAN Connector

Pin Function Colour

1 GND Brown

2 CAN L Green

3 CAN H White

4 +14V Yellow

The DC5 Honda Integra Type R plug in ECU uses two serial communication buses to talk to systems in the
factory vehicle. To make sure these systems work properly ensure that these systems work properly setup
the two serial ports as shown below.
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DC5 plug in ECU Serial Port setup

Note: The AC Request is received on CAN DI 1.

1.10 Known Issues

All plug-in ECUs are fully tested on a range of relevant vehicles, although there are often variations that have
not been tested. For this reason issues can arise.

WARNING: Always download the latest Installation Manual from linkecu.com and check the latest status of
known issues before installing the ECU.

Please contact your nearest Link dealer when suspecting a compatibility issue.

1.10.1 DC5 Honda Integra Type R

The Immobiliser light may not stop flashing, if this is the case contact tech support as there may be a
software fix for it.

V1.7 or earlier revision boards had the fuel pump output connected to pin E1 only, it has been discovered
some DC5 models without a factory immobiliser use a different pin to control the fuel pump. If your fuel pump
does not prime/run and you have a DC5 that came without the factory immobiliser then the fuel pump wire will
need to be moved from pin E10 to E1. Note this only applies to bottom board revision V1.7 or earlier, V1.8
and later have been fitted with a jumper to allow the correct fuel pump pin to be selected.
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